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Cautions

1. Do not install and use the unit in moisture, high temperature, outdoor, and closed
environment.

2. Please turn off the power supply before cleaning the unit. Spary cleaning solution
on rag to wipe down unit. Do Not spray cleaning solution directly on to unit.

3. Do not block air vent and other holes, do not install the unit beside near any heat
source, and other devices which may affect the ventalation.

4. In order to avoid the high voltage risk, please do not attempt to disassemble and or
repair the unit, please call your representative or ask a professional to maintain if a

problem accours.

5. Use the unit under a stable power supply. Do not use it with another high power
device from the same power supply, this may affect the unit, or even damage it.

6. Turn off power or remove the power cable and network cable during a thunder
storm or severe weather.

7. Power off the unit if it is not being used or has stoped working.



High Definition AD Player User’s Manual

Contents:
PACKING IS ...ttt ettt bttt st e b b e b et e st et e b e b e st et en e be b nens 4
1. ProduCE INtrOAUCTION. .....coviieieiicie ittt sttt sb ettt sttt n et sre e 5
2. REMOLE CONLIOL ...ttt sttt bbbttt st st e e b e besbe e 7
KT (=] 0 0 T T=1 1] oo RS PRTR 10
R TR VS (=T (ST o RSP 10
3.2 Playback CONLIOL.......couiiiieiieeiie ettt sttt 13
3.3 DA & THMB .itiiiiciiic ettt et e et t e b e beeae et eete e be st e beeteereenresrearas 15
B4 ON Y OFF TIMEBE ettt ettt ae et e s be s be e e s besteareenrestearas 16
BB LOCAIID .ottt re e nresbearas 17
3.6 SCIEEN IMOUE ...ttt et e et e b et e st e e te e besbeebeessesbesbeareentesbearas 18
3.7 Fle MANAGEIMENT.......cuiiieeiiteert ettt bbbttt bbbt b et b et eb e nes 18
T 0 | RSO P 18
O T o LU LA o) g A T=1 11 ] o [PPSR PRSP 19
4.1 SOUICE. ...ttt E e Rt R R et eR R R R R e nr e 19
A (=] 0 IS T=1 LR 10T ST 20
e B [ 172 o T PR P PP PP PP PPPOPPPN 20
5. ADPIaylistEItOr INtrOQUCTION.......c.viiiiiiieie ettt seenne s 21
5L INSTAHALION ...t bbbt r e 21
oI o Y LTS O =T 11 T o SR 25
TG I YT T [T 3SR 29
5.4 SAVE TO USB ... 30
6. CONLENE UPUALE ....veeeeiecie ettt e sttt e e s e stesteeneetestesraeneenrenneas 31
6.1 Update CONLENT AIFECLIY ....vevviieiiieciee sttt nenreens 31
6.2 Update cONtent Via ADPE .........cocooiiiiiiee ettt nrennas 31
7. Screen Template DIMENSIONS .......ecviieiiiieieie e te et eaesre e esaessesresreeneenrennens 32
6.1 Horizontal template diMenSIONS..........ccoveieiiiiiiieee et nee e 31
6.2 Vertical template dimeNSIONS .........ccueiiiiieieiesr e see e 31



High Definition AD Player User’s Manual

Packing list

In the carton, you will find the following:

LCD display

Remote controller

Wall plate (on all PF series below 42”)

Power cable

Key

CD

Allen Key (for L Series display only, to remove handles)

VV VYV Y YVYVY
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1. Product Introduction

1.1 Overview:

High definition LCD display, support pictures, video, text, time & date, 1080P HD media files.
ADPE software can provide multi zone function for both horizontal and vertical mode; customized
templates are available for users with different requirements.

1.2 Product function

Built in 4GB flash memory

28 transition modes to choose from

Supports scrolling text

Set the timer On/Off function daily or weekly

Set different schedules, and play it back accordingly

Display your screen in both landscape and portrait modes

Support multiple zone templates, different templates are available

An external media player can be used via the screens VGA or HDMI input ports
High security encryption function can be used to protect your content

Read media files from USB stick directly, or input the media files from USB stick to
internal flash memory

1.3 1/ O ports introduction

REST: Restart button for PF Series displays only
LAN: Development use

HDMI: High definition HDMI signal input port
VGA: VGA signal input port

Audio: Audio input port

USB: USB stick port, used to input media files

The unit can playback media files from internal flash memory or USB stick directly.

1.4 Supported media files format

Item Description
Image Support JPG, BMP, PNG
Video Support MPG, AVI, MOV, MP4, RM, RMVB, TS

Scrolling text

Support scrolling text, can set the font size, color and scrolling
speed
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1.5. Wall Mounting Plate for PF Series
Hole For VESAMount

1.6 1/O Ports Cover
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2. Remote Control

Remote instruction

Button Description

POWER

XY

b
+ (volume)
- (volume)

PLAY/PAUSE

?

—

\

<+
STOP

SETUP
MUTE

Power on or off

previous program

Next program

Raise volume

Lower volume
Play/Pause,Confirm selection
Up,navigation button
Left,navigation button
Down,navigation button
Right,navigation button
Stop the selected file

Menu setting

Change video input
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Replace remote control battery
1. Open the battery cover

2. Take out the battery box in the right direction as the following picture shows
3. Remove the used battery

4. Insert the new battery in the right way
5. Put back the cover

-~
1’
-~

In order to enter the setup menu you must first press the “stop” button on the remote to go back a
screen as picture below. Then press the “setup” button on the remote.

.
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The location of the IR remote receiver on both the PF & L Series as pictured below.

IR Remote Receiver
Location

IR Remote Receiver
Location
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3. System Setting

Main menu pictured below.

&

System Settings

Playback Control
Date & Time
On/Off Timer_”

Local ID

Screen Mode

File Management

Q=@oe-

2012/05/07 Monday 1758 Version : 1,2.3

TIPS: By pressing the PLAY / PAUSE button on the Remote Control, you can go into the
sub-menu or confirm the item you choose, use the arrow navigation buttons to choose the
item you want.

3.1 System Settings

Under system settings you can set the OSD Language, Clock Display, Scrolling Text, USB
Port, Restore to Factory Settings, and Return to Main Menu.

10
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OSD Language

The OSD supports four languages — Simplified Chinese, English, French, and Japanese, are
available now more languages will be supported in the future.

System Settings

Scrolling Text

USB Port

Restore To Factory Settings

Return to Main Menu

2012/05/07 Monday Version : 1,2,3

Clock Display
There are 4 options as pictured below :
® Top Left: The time will be displayed on top left of the screen.
® Bottom Left: The time will be displayed on bottom left of the screen.
® Top Right: The time will be displayed on top right of the screen.

® Off: The screen doesn’t display time.

System Settings

0SD Language English V|

Off

B o) Left
Scrolling Text Bottom Left

- ll Top Right
USB Port

Bottom Right

Restore To Fact S

Return to Main Menu
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Scrolling Text
There are 2 options as pictured below; the default setting is “On”.

® Off: The screen doesn’t display scrolling text.
® On: The screen will display scrolling text from the txt file in the playlist, if there is no playlist
or there is no txt file in the playlist the screen doesn’t display scrolling text.

System Settings

0SD Language English V|

Clock Display Top Left v

Restore To Factory Settings

Return to Main Menu

Version : 1,2.3

USB Port
There are 2 options as pictured below, the default setting is “On”.

® On: The product can support the USB device.
® Off: The product can not support the USB device.

System Settings

0SD Language English

Clock Display Top Left

Scrolling Text On

2012/05/07

12
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Restore To Factory Settings

After factory settings are restored all system settings will default back to their original settings

System Settings

OSD Language English n
Clock Display Top Left n

Are you sure you want to
restore to factory settings?

3.2 Playback Control

Storage Priority
This is used to set the LCD display to read media files from Internal Storage or USB Disk.
There are two options as pictured below:

® Internal Storage: The LCD display reads media files from the internal storage only
® USB Disk: The LCD display reads media files from the USB disk only

Playback Control

Internal Storage

Internal Storage
Playback Mode [EEEnn

Play Time

Return to Main Menu

yl-- I
| S

13
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Playback Mode
There are three options as pictured below:

® Free: The user copies thier media files on to the USB stick and the LCD display will read
directly fromit.

® Encrypted: The user makes the playlist with encryption by using the ADPlaylistEditor3
software; the LCD display will read the media files after verifying the password. (The
default password is 12345678)

® None Encrypted: The user makes playlist without encryption by using the software
ADPIlaylistEditor3 software; the LCD display will read the media files directly.

TIPS: Under the Free Playback Mode, the LCD display will playback the media files according to
the file name. For example, it will playback like this: 001.avi, 002.jpg, 003.mov, or a.avi, b.jpg,
c.mov.

Do Not Use special characters in the file name. (1@# ¥ %&*) and blank space are not

supported.
Playback Control

; 5 |
Internal Storage
None Encrypted
Free
Encrypted

Return to Main Menu

e
.
et
gos o B
5 e y -
i - .‘. ,,.. L - e
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Play Time
This is used to set the play time for pictures under the Free Playback Mode and is not valid for
video files.

Playback Control

Storage Priority |
Playback Mode

3.3 Date & Time

Procedure is listed below:
1. Choose Date & Time in the Main Menu, and press PLAY/PAUSE to go into the sub-menu.
2. Press Left or Right Navigation buttons to choose the item you want to modified.
3. Press Up or Down Navigation buttons to change the number.
4. Choose Update Date & Time to save your settings.

Date & Time

Month Hour Minute

=

Update Date & Time

Return to Main Menu

15
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3.4 On/ Off Timer

There are 2 Timer Modes to choose from pictured below.

2012/05/07  Monday 18:00 Version : 1.2.3

® \Weekly
User can set the on/off timer weekly. For example, on Sunday, 6:00am on, 11:00am off:

1. Choose Weekly in the On/Off Timer menu, press PLAY/PAUSE to confirm, see below.

Status On Time Off Time

Return

— —
7 Version : 1.2.3

2. Choose Timer on/off in the Control Mode, then the three Timer items are valid, Choose the
Status of Timer(1) to be ON, then make the On Time to be 06:00, Off Time to be 11:00.

3. Choose Save New Settings to finish the setting

16
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® Daily
User can set the on/off timer daily.

Choose Daily in the On/Off Timer menu, press PLAY/PAUSE to confirm, see below.

Timer On/Off
Keep On
Status Keep Off

imer (1) )
Timer (2) ]
Timer (5 NG

Save/Active New Date

Retumn

There are 3 items for option:

A.  Timer On/Off: user can set 3 groups Timer, each group can set “On” or “Off”.

B. Keep On: after connecting the power cable, the product will keep power on.

C. Keep Off: after connecting the power cable or turn on the unit by remote control, the
product will power off automatically one minute later.

3.5 Local ID

Set the ID as pictured below, it only works when you need to use the network function. After
setting, choose Save to finish it. (not available at this time)

17
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3.6 Screen Mode

Set the screen to horizontal or vertical display for landscape or portrait use.

Screen Mode Setting

Horizontal ~ Vertical

Tuesday Version

3.7 File Management

Here user can check the storage and Format the disk. Format Disk will erase all data, please
be cautious.

|

Storage: UDISK Storage: UDISK

File System: fat32 File System: fat32

Capacity: 3.55GB

i Warnning:Formating will erase all data

Used Space: 2.44MB £ * . on the disk! Press "Ok" to continue
or "Cancel" to quit.

Free Space: 3.55GB

. -1

3.7 Exit

The system will exit the main menu.

18
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4. Input Port Setting

Press MUTE button of the remote control, below menu will pop up, this is used to choose the
input signal and other system setting.

Menu

Source
System Setting

Image

1920%1080 50Hz

4.1 Source

There are HDMI, VGA, and Digital Signage to choose from.

HOMI

VGA

Digital Signate

Return

1920%1080 50Hz

HDMI: Display the content from external HDMI signal port
VGA: Display the content from external VGA signal port
Digital Signage: Display the content from internal digital signage system

19
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4.2 System Setting

OSD Language: Simplified Chinese and English
Reset: Reset will restore the system to what’s listed below:
Language: English
Source: Digital Signage
Brightness: 50
Contrast: 50
Saturation: 50

System Setting

0SD Language
Reset

Return

1920%1080 50Hz

4.3 Image

Here user can set the Brightness, Contrast, and Saturation.

Brightness
Contrast

Saturation

Temp

Return

1920%1080 50Hz

20
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5. ADPlaylistEditor Introduction

ADPIlaylistEditor (here after called ADPE) is a fantastic solution for digital signage, it is an
innovation that entertains while maximizing the impact of your message. Create your own signage
content by using your PC and the free ADPE software.

Transfer that content by using a USB stick and plug it into the LCD display to run the content,
no additional hardware is needed.

5.1 Installation

® Install Microsoft .Net Framework 3.5

The installation of ADPE need Microsoft .Net Framework 3.5, user can double click
Dotnetfx.exe in the accessory CD-ROM, or click below link:

http://www.microsoft.com/downloads/zh-cn/details.aspx?familyid=333325FD-AE52-4E35-B
531-508D977D32A6&displaylang=zh-cn to download and install it.

I Microsoft .NET Framework 3.5 SP1 (Beta) Setup i =10 %}
Mscrosoft

welcome to Setup .NEt Framework

Be sure to carefully read and understand all the rights and restrictions described in the
license terms. You must accept the license terms before you can install the software.

MICROSOFT PRE-RELEASE SOFTWARE el
:LICENSE TERMS o

Press the Page Down key to see more text. E}

(" 1have read and ACCEPT the terms of the License Agreement
(" 1DO NOT ACCEPT the terms of the License Agreement

[T Send information about my setup experiences to Microsoft Corporation.

Detads regardng the dats collection polcy

Download File Size: 71 M8

Download Time Estimate: 2 hr 54 min (56 kbps)
19 min (512 kbps)

[ [oe
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® Install FinalCode.exe

FinalCode is used to decode the media files when you use the preview function in the ADPE
software, it is suggested you install otherwise the preview function may not work well.
Double click on the installer "FinalCode.exe" and follow the on-screen instructions:

¥ HnalCodecs 1.11.0629 Setup

|'§ FinalCodecs 1.11.0629 Setup

Plaase review the licanse terms before instaling FinalCodecs 1.11.0628, Choose which features of FinalCodecs 1.11.0629 you want to install,

Pt PR Dol o oo e sorne séectbevpeofnnt (T -

FinalCodecs 1.11.0629 |a] Or, select the optional @ [V Player and Too's
components you wish to ) [V] Splitter Parser Reader

FinalCodacs provide a good sofution to most popular media files. It ts high!: nstall

recommended to first uninstall other related codec packages before installi

® 4 Video Cadecs
@ [v] Audio Codecs

package. This way your system stays clean and potential prodlems [¥] avidia Codecs
installer i3 abls to automaticaliy datect 3 lot of codac packs and it will ask you if you [#] somic Codecs
want 10 uninstali them. EEDShow Codecs
Sdxy - Subtitles: VobSub 240/233
|+ D fdist11 (Codec al dy installed)
v Play

If you accept the terms of the agreement, dlick I Agree to continue. You must accept the Space required: 263.6M8 Rei : et j:xe o
agreement to install FinalCodecs 1.11.0629. QuickTime Alternative

i Agree Cancel | [<§w’t ][ ﬁext>]lCmcd ]

% FAnalCodecs 1.11.0629 Setup

% HnalCodecs 1.11.0629 Setup

Choose Install Location Installing
Choose the folder in which to instal FnaiCodecs 1.11.0629, é Please wait whie FnalCodecs 1.11,0629 is being instaled. ﬁ

Setup will install FinalCodecs 1.11.0623 in the folowing folder. To instal in a different folder, Extract: C:'\Program Fles\Final Codecs'PotPlayer.dl... 66%
chick Browse and select another folder, Click Install to start the instalation, ARAAR

[ Bowse.. |

Space required: 269.6M8
Space avalable: 17.9G8

—
% FinalCodecs 1.11.0629 Setup X

"W File Assodation Tool

Completing the FinalCodecs

Specify File Association "b 1.11.0629 Setup Wizard

Choose Medis Format you want to Associate
FinalCodecs 1,11.0629 has been installed on your computer,

Associste to y Plyer: SRy T R - CickFrish to cose th wasrd,
"""""""""""""" # [ QuickTine Movie -
# [ Real Media File

® |7 Popular Video, DVDRip, MPEG-4
(& [7 WPEG, HDTV/DVD/VED Media
@ [7 Other Video file
@ [7 Aninstion file
® [V Windows Media File
[ Shockrave Flash
i [7 Smacker/Bink Animation
@ [T Lessless Audio File b
4

e

) (o)

22
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® Install ADPlaylistEditor

Double click on the installer "setup.exe" and follow the on-screen instructions.

|81 Setup - ADPlaylist3

Welcome to the ADPlaylist3 Setup
Wizard
This will instal ADPlayiist3 ver1.0.0913 on your computer,

1t is recommended that you dose all other applications before

continuing,

Cick Next to continue, or Cancel to exit Setup.

] [ cancel |

[ngt >

Select Start Menu Folder
Vihere shoukd Setup place the program's shortcuts?
Setup will create the program's shortauts in the foliowing Start Menu folder,

To continue, cick Next. If you would ke to select a different folder, dick Browse.

|Don't create 2 Start Menu folder

<§ack_][ fsext > J Cancel

#1 Setup - ADPlaylist3

Ready to Install
Setup is now ready to begin instaling ADPlaylist3 on your computer.

Click Install to continue with the installation, or diick Back if you want to review or
change any settings.

Destnation ocation:
C:\Program Fies\Sign'Way\ADPlayist3

Start Manu folder:
ADPlayist3

Addtonal tasks:

Add short cut:
Create shoct cut

[ <gec [ jostal ] [ concel

23

Select Destination Location
Where should ADPlayist3 be instaled?

Setup will iInstall ADPlayist3 into the following folder.

To continue, cick Next. If you would tke to select a different foider, dick Browse.

Atleast 104.6 MB of free disk space is requred.

Setup - ADPlaylist3

Select Additional Tasks
Which addtional tasks should be performed?

Select the additional tasks you would like Setup to perform whie instaling ADPlayiist3,

then dick Next,
Add short cut:

7] Greate shoct st

Cancel ;J

<geck [ text> ]

=

| §1 Setup - ADPlaylis

Completing the ADPlaylist3 Setup
Wizard

Setup has finshed nstaling ADPiayist3 on your computer. The
appiicaton may be launchad by salecting the instalied icons,

Cick Finish to exit Setup.
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Run the software
User may need to install another software if below Error pops up when you run ADPE.
Double click vcredist_x86.exe in the accessory CD-ROM which is a system patch.

OpenCvsharp Error, b__<|

An exception has occurred because of Pilnvoke,
Please check the following:
1, OpenCy's DLL Files exist in the same direckary as the executable File,
2, Misual C++ Redistributable Package has been installed,
3, The target platform{x86 64} of Opench's DLL files and OpenCySharp is the same as vour project's,

System.DINotFoundException: Unable ko load DLL ‘opency_imgproc230°: The specified module could not be found. (Exception From HRESULT:
0%8007007E)

at OpenCvsharp, CvInvoke, cvReleaseHist{IntPhrés hist)

at OpenCysharp. Utilities PInvokeHelper, TryPInvoke)

Interface

L ADPLyLstEditor
Ele  Took MHed 1

T A @lkd 8 D W € ©

New Open Cote Sive Save As | Options Phyer Settngs  Preview - Sive to USE

©

o No Active GPL (&)
Schedule

®

Date Tine Scresm Bods

- Vews e -

VID 00.00.00 @
Add

Scrolbng Text  faceding FoatSiae Coler Sarallingipeed 5 Colar Treapwrency

N
-

1. Menu Bar: Provide access to all the features of this software.

2. Media Library: Helps the user locate media files on thier computer and gives previews in
the bottom box. Supported formats include:

o Video: av, divx, mp4, mpeg, vob, h264, ts, tp, m2ts, flv, mov, mdv, mkv,
wmv, rmvb, rm

e Image: jpg, bmp, png, gif, jpeg

¢ Audio: mp3, wma, 0gg, aac, wav

o Text: txt

3. Tool Bar: Provide access to the main functions.

24
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o New - create a new program.

e Open - open a program file already exists.

e Close - closes all the current files and clears the work space.

e Save/Save As - save your current work with the name as *.gpl.

e Options — allow user to setup a playback duration and transition style for all the
images.

e Player Settings — allows the user to change the settings on their screens.

e Preview - preview the current file.

e Save to USB - saves the content and schedule to a USB disk.

4. Program Name: Display the name of the current program. It will be named as
Untitled-*.gpl by default.

5. Schedule Section: Defines the start and end time of a file, as well as the screen layout.

6. Playlist Section: Allow user to add media files to the playback zones.

5.2 Playlist Creation

® New Screen
First choose the screen mode.
Click File -> New in the menu bar or click the button New on the tool bar to get below dialog

box.

@9 : 186
[ ]

Select the appropriate screen mode, this must be the same as the screen mode in the main
menu, otherwise it will affect the displays performance.

® Schedule
User can set the schedule according to the requirement.

V| Schedule

j Date o : Time EScreen Mode‘ I Add
m— 7 p— Full Screen(Horizo. ..

2012-05-16 -> 2012-05-16 13 : 00 -> 14 : 00 Splitl VID(L)+PIC( ..
Modi £y

Add — add an extra new schedule

Remove - delete the selected schedule

Modify - edit the selected schedule

To add a new schedule, click Add to get Schedule Editor as below.

25
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of Schedule Editor Xl

[T Wste 7] Time -

L [1) ¢ ] [ Cancel ]

Selecting the checkboxes Date and Time allows the user to setup the playback duration. It also
allows user to change the screen mode.

TIPS 1: There are three Screen modes for option as example under 16:9: VID which can display
videos or pictures only, VID+PIC+BOT which can display videos on left, pictures on right and
scrolling text at bottom, PIC+VID+BOT which can display pictures on left, videos on right and
scrolling text at bottom.

TIPS 2: One period time allows one schedule only, otherwise conflict alert will be given. If you
don’t set the Date and Time, the content will display continually.

The playlist with specific playback date and time will be played prior to those with no
pre-definition. Take the following schedule for example:

Date Time | Sereen Mode

————f=f— it L Full Screen(Horizontal)
F01Z2-05-16 -» 2012-05-16 13 : 00 - 14 : 00 Splitl VID(LI+PIC (RI+EOT

The second playlist will be played first during 13:00->14:00 on 2012-05-16 and the first playlist
will be played second.

® Set up Playlist
Playlist section allows user to add media files to playback zones to setup a playlist.

VID 00:00:30 |PIC |BOT I
" X f o | Add |
1 .m 1.mpg Fak 00:00:30 ‘n Edit ]
. Delete ]
Up ]
]

. o — Down
3 l:Jz.mpg N 00:00:31 {n

26
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Click the relevant tab title to edit content for the zone:
VID - video zone, PIC - image zone, BOT - bottom zone

Add - Adds a media file to the current zone.

Edit - Allows user to edit a media file in the playlist.

Delete - Removes a media file from the playlist.

Up/Down - Allows user to adjust the playback sequence of listed items.

For example, in VID tab, click Add to get PlayList Iltem Editor.

B Playlist Item Editor X

Medis File

o

R
WJ]?E B3 = &
Sy ‘“E-r |:‘Iu % [7?

[ ok ][ Comear |

E «Eﬁ

Media File

To add video, image and audio file, click the button Browse in PlayList Item Editor window.
TIPS: User can only click the Add button in the Media Library to add media files.

NOTE: Only image files can be added to PIC and BOT zones.

The maximum number of media files is 100 for PIC and BOT zones. Only one media file can be
added to BOT zone.

27
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| B playlist Item Editor

m i.Et\mcni\IllG\l.yn;

[ ox ][ Cancad |

The Duration and Transition Style portions will only be available when an image is selected as
the media file.

Duration: Sets the period that the image will be played. User can define the playback duration for
each image by entering a figure in the time box or dragging the time bar. The supported maximum
duration is 2 hours.

Transition Style: The transition effect is used to introduce the next image. User can define the
transition style for each image.

TIPS: The Options button in the Tool Bar allows you to setup a uniform duration and transition
style for all images.

Scrolling Text: To add or edit scrolling text, select the checkbox at the lower part of the Playlist
section.

V) Scrolling Text| Encoding|Aute  |v FontSize(20 v Color (MMlJScrollingSpecd Slew v | EG Color (Il Transparency 0% v
{Please type text here ‘

Y/ |

|

Browse

® To add a scrolling text, click the button Browse to select a pre-prepared text file which will
then be displayed in the edit box.
NOTE: Only *.text files are supported.

® To edit a scrolling text, just enter the text in the edit box.

® To delete a scrolling text, just uncheck Scrolling Text.

User can set the Encoding, Font size, Color, Scrolling speed, back ground color and Transparency
of the scrolling text.

28
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The scrolling text will be displayed at the bottom of the screen in full-screen mode, or in BOT
zones in split-screen modes.

Now the user can preview and save the finished playlist.

5.3 Player Settings

The Player Settings button on the tool bar allows user to make settings on the player. These
settings can be imported to the player via the feature Save to USB.

TIPS: To import these settings to players, the user needs to enable this feature by clicking the
Player Settings box in the Save to USB window.

Click Player Settings to get the window pictured below:

¥ Config System x|

0SD Language w3 = Brightness ' 9 S50 (A
Clock Display Top Right |»! .
e —- - Contrast U 50 24

Serolling Text 0ff -
ey Loge < ” Saturation ~ O 50 12
Inport Mode
Sync Mode

g Sunday

) Control Mode Timer On/Off b
Timer Hode |[TRTATNNN

| Tmer | OnTime | Off Time

Bonday Tuesday Nednesday
Control Mode Timer On/OfE - Control Mode Timer On/Off - Control Mode Timer On/Off vl
| Timer On Time OF Time Timer | On Time Off Time Times On Time Off Time
Thursdsy Friday Saturday
Control Mode Timer On/O£€ - Control Mode Timer On/Off v Control Mode Timer On/OfE -
Timer |  On Time Off Tima Timer |  On Time Off Tme Timer |  On Time Off Time
[ Pactory Settings Lo ][ Cuca

The above menu is the same as the Main Menu set by remote control.

29



High Definition AD Player User’s Manual

5.4 Save to USB

The function Save to USB allows user to save the finished playlist to a USB disk for input
into the LCD display.
Click Save to USB in the Tool bar or click Tools -> Save to USB.

=¥ Save to USB

Flayer Type: 7 Xxes © s¥110

Removable Disk

| A1l Removable Disks

" | Enerypt

| Player Settings

[ 0K ][ Cancel .y

®  Select the player type, X86 or SW110. SW110 is for standalone type LCD display.
Insert a USB disk, and then select the disk you wish to save to.
® Choose whether to encrypt the playlist. This step is not necessary.

Select the checkbox Encrypt to enable this function. Then click the button Password Setting
to change the password if necessary.

Please note that the password should be the same as the player password, otherwise the
playlist cannot be imported into the LCD display.

TIPS: The password can also be setup via Tools -> Password Setting, and the player
password via Tools -> Player Password Update. The default password is 12345678.
® Player Settings. This step is not necessary.

Select the checkbox Player Settings to enable this function. Then click the button Player
Setting to change the settings if necessary.

TIPS: The player settings will be packed together with the playlist and then imported into
LCD display. This step is not necessary.

Click OK to finish.
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6. Content Update

6.1 Update content directly

If user doesn’t want to use ADPE to make their playlist, They can copy their media files on to
a USB stick and plug it into the USB port of the LCD display.

If the Storage Priority in the Playback Control Menu is set to USB Disk, then the LCD display
will playback the media files directly.

If the Storage Priority in the Playback Control Menu is set to Internal Storage, then the media
files will be imported into the internal storage and will playback the media files after they are
uploaded.

6.2 Update content via ADPE

After making a playlist and saving it to the USB successfully by ADPE, plug the USB into the
USB port of the LCD display.

If the Storage Priority in the Playback Control Menu is set to USB Disk, then the LCD display
will playback the content in the playlist directly.

If the Storage Priority in the Playback Control Menu is set to Internal Storage, then the media
files will be imported into the internal storage and will playback the media files after they are
uploaded.
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7. Screen Template Dimensions

These are the sizes need to set-up your files to proportionally fit the zones.

7.1 Horizontal (Landscape) dimension

anl

1280x960

BOT  1920x120

7.2 Vertical (Portrait) dimension

TI)F 1080x180

TIF 1080x180

A

1080x808

FIC

1080x808

van

1080x808

FLC

1080x808

BT 1080x124

BT 1080x124
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